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Какво е LesView? 
 
LesView е информационна система предназначена за нуждите на лесничействата и 

дивечовъдните стопанства. Системата дава възможност за бързо и лесно намиране на 
подотдели по пълния набор от таксационни характеристики, преглед на таксационни описания, 
създаване на справки, готови справки, таблици,  разпечатване на таксационни описания и др. 

 
Минимални изисквания за инсталиране 

 
 Операционна система: MS Windows 9x, 2000 и XP.  
 Компютърна система:  

• процесор Pentium II 300Mhz 
• опеаративна памет 64MB (препоръчително 128MB) 
• свободно дисково пространство ~50MB 
• разделителна способност на екрана 800х600 (препоръчително 1024х768) 

 
 
1. Инсталиране 

 
 
• Поставете инсталационния диск във вашето CD-RОМ устройство 
• Изчакайте автоматично да се зареди инсталационния прозорец (в случай, че  

е изключена опцията за автоматично стартиране на компакт диска трябва да 
стартирате ръчно файл autorun.exe) 

• Натиснете бутон “LesView” 
• Следвайте по нататъшните инструкции, които Ви дава инсталиращата 

програма 
 
 

2. Стартиране на програмата 
 
Ако не сте променяли опциите които Ви дава инсталиращата програма стандартно 

стартирането на LesView става от меню: 
 
Start → Programs → Agrolesproject → LesView → LesView 
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3. Работа с програмата 
 

 
 
 

3.1  Общ изглед 

3.2  Справки 

3.3  Печат 

3.4  Таблици 

3.5  Икони 

3.6  Менюта 

3.7  Експорт 

3.8 Импортиране и обработка на таксационни описания и  
       предотделни листове в  MS Word 
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3.1  Общ изглед 
 

 
 
 
Основния изглед на прогрмата дава възможност за преглед на таксационни описания. 

Интерфейса е лесен, интуитивен и удобен за работа. Бъдещия състав е отделен в отделна 
секция: 
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3.1.1 Избор на проект 
 
Когато в програмата е инсталиран повече от един проект, менюто за избор на 

проект е активно (Файл -> Избор на проект) 
 

При стартиране се показва прозорез със списък на инсталираните проекти. Ако 
желаете всеки път когато стартирате програмата да се отваря последния отварян 
проект то тогава активирайте отметката “запомни последния отварян проект”. 

 

 
След като направите вашия избор натиснете бутона Ок. 
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3.2  Справки 
 

  
 
3.2.1 Сито за сечите 

 
Този вид справка дава възможност да извършвате търсене по всички видове 

проектирани сечи. Ситото е разделено на две основни части Критерий и Резултат. 
 
В частта Критерий се задава вида на сечта, като тя се определя от един до девет 

вида показателя (Сеч 1, Сеч 2, ..., Сеч 9). В зависимост от това за конкретния проект 
до колко вида сеч са въведени програмата автоматично разрешава и забранява 
възможността за избор. 

 

 
 
Меню: 
 

• “Филтър -> Търсене” -  Изпълнява търсене спрямо зададените критерий 

• “Филтър -> Изчисти критериите” - Изчиства зададените критерии 

• “Редакция-> Копирай” -  Копира в паметта списъка на намерените 

подотдели, общатата им площ и брой. След като сте копирали списъка 

използвайте командата Paste на текстовия редактор или електронни 

таблици с които работите (MS Word, MS Excel) 
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• “Редакция-> Зареди избрания подотдел” -  Зарежда избраното 

таксационно описание от списъка на намерените подотдели в основния 

изглед 

•  “Файл-> Запиши резултата като” – Записва резултата във файл,  с 

възможност за избор на формат MS Word и MS Excel 

• “Файл-> Изглед преди печат” – Показва страниран резултата преди да 

бъде отпечатан 

• “Файл-> Печат” – Отпечатва резултата 

• “Файл-> Печат на таксационни описания” – Отпечатва таксационни 

описания за всички подотдели от резултата 

 
 

 
3.2.2. Сито работно  - Общ изглед 
 
Ситото е предназначено за създаване на произволни справки по различни таксационни 

показатели, като резултата от справката може да бъде копиран, записан във файл или 
отпечатан. 
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3.2.2.1 Настройки 
  
Меню настройки слижи за избор на показатели, които да бъдат включени в резултатите при 

филтриране на даанни. 
 
  

 
 
 
 

 
Двата 

бутона “Избери 
всички” и 
“Изчисти всички” 
служат съотвено 
завключвана или 
изключване на 
всички показатели 
от листа за избор.  

 Потвърждав
ането на 
показателите става 
с бутон “Ок”, ако 
желаете да се 
откажете и да се 
запази предишния 
избор натиснете 
бутон “Отказ”. 
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3.2.2.2 Създаване на справка 
Търсенето се извършва само по показателите за които има зададена стойност, ако някои 

от вече зададените показатели трябва да се изключи от критериите за справката то трябва да 
се изтрие стойността му с клавиша за изтриване Delete или Backspace. 

 

 
 
  

Избора на стойности за 
повечето показателите става чрез 
падащи менюта. Виж точка 1  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

При някои от показателите избора става в зависимост от тяхната специфика. 
Включването на показателя “Възраст” в справката става с помоща на бутона в дясно 
от него, които активира прозореца за задаване на критерийте за възраста. Виж 
точка 2 
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Включването на вид сеч в справката става с помощта на бутона отдясно на полето 

за вид сеч. Виж точка 3 
 

 
 

 
След натискане на бутона се показва 

прозорец за задаване на вид сеч. Ако желаете да 
изключите вид сеч от справката трябва да натиснете 
бутона Изчисти и след това да потвърдите с бутона 
Ок. 
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След като са дефинирани показателите по които да бъдат филтрирани подотделите, 
натиснете бутона за изпълнение на справката. Виж точка 4 

 

 
 
 3.2.2.3 Резултат 
 След изпълнение на справката резултата с филтрираните подотдели и избраните 

показатели се показва в табличен вид. Виж точка 5 
 

Показателите които 
излизат в резултата (в 
примера: отдел, подотдел 
площ, землище, вид 
подотдел, стопански клас) 
зависят от това което сме 
избрали от меню 
“Настройки” -> “Избор на 
показатели”.  

(виж 1.1 Настройки) 
 
 
 
 
 
 3.2.2.3.1 Обработка на резултата 
 В зависимост какво ви е необходимо, резултата от справката може да бъде копиран и 

поставен в друго приложение, отпечатан или записан във различни файлови формати. 
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3.2.2.3.1.1 Запис на резултата във файл 
 Меню “Файл” – “Запиши резултата като” /виж точка 6/ записва резултата в нов файл, 

като  формата съответно може да бъде MS Excel или МS Word.  
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3.2.2.3.1.2 Отпечатване 

 Меню “Файл” – “Печат” /виж точка 8/ Отпечатва директно резултата на принтера 
които е избран по подразбиране.  Меню “Файл” – “Изглед преди печат” /виж точка 7/ показва 
как ще изглежда резултата преди да бъде отпечатан. От меню “Printer setup” /виж точка 11/ 
може да бъдат направени настройки на печата, като избор на принтер и корекция на 
настройките му /виж точка 12/, промяна на шрифта за печат (в случай че имате проблем с 
кирилицата) /виж точка 13/, промяна на полета за печат /виж точка 14/. 

 

 
 

 
 
3.2.2.3.1.3 Печат на таксационни описания  
Тази опция Ви дава възможност да отпечатате таксационни описания за всички 

подотдели които са попаднали в резултата. 
 
В зависимост от това какво желаете да отпечатвате трябва да 

включите/изключите отметките за Таксационни описания и Предотделен лист.  
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При активиране на отметката за предотделен лист се активира секция 
Настройки, в която трябва да изберете една от двете опции: 

 
 всички подотдели за отдела 

– включва всички подотдели за 
отдела в преотделиния лист 
независимо дали са във 
списъка с филтрирани 
подотдели 

 само филтрираните 
подотдели – включва само 
филтрираните подотдели в 
предотделния лист като 
преизчислява сумарните 
стойности. 

 
 

 
 
 
 
3.2.2.3.1.4 Експорт във файл на таксационни описания 
 

 
Експорта ви дава възможност да 

запишете в текстов файл всички 
филтрирани описания и техните 
предотделни листове. Бутона за експорт 
на описания и предотделни листове се 
активира след като изпълните справка 
резултатът от която трябва да е поне 
едно филтрирано описание. Опциите при 
експорт са аналогични с тези при печат 
(1.3.1.3 Печат на таксационни описания). 
След като запишете данните във текстов 
файл, може да ги отворите с произволен 
текстов редактор за допълнителна 
обработка и печат.  

 
За повече информация вижте 

разделите “Експорт” и “Импортиране и 
обработка на таксационни описания и предотделни листове в MS Word” от пълното 
ръководство на програмата. 
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3.2.3 Сито ОБС (бъдещ състав) 
 

 
Ситото е предназначено за създаване справки в бъдещия състав. В справката 

може да се включват едновременно показатели и от сегашния състав. Значението на 
бутоните е идентично с предходните (виж  3.2.1.1).   

 
3.2.4 Списък на сечите 
 
показател – може да фитрирате сечите по зададен показател и стойност, ако 

искте да изведете всички предвидени сечи то в опцията показател изберете:  
“-всички-” 
След като сте създали списъка може да го копирате и да го вмъкнете в документ 

на MS Word или друга текстообработваща програма. 
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3.2.5 Списък на мероприятията 
 

 
виж  3.2.4 
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3.3  Печат на таксационни описания и предотделни листа 
 

 
3.3.1 Единичен печат на таксационни описания 
 

 
Ако желаете в сегашния състав  да има запас и ползване с клони трябва да 

включите отметката.  
Единичния печат дава възможност за изборно отпечатване на таксационни 

описания.  
 
Бутони: 
 

Име Описание 

 
Показва таксационното описание преди да бъде отпечатано 

 
Отпечатва таксационно описание на зададения подотдел 

 
Отказ от печат 
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3.3.2 Поточен печат на таксационни описания 
 

 
Поточния печат дава възможност за поточно отпечатване на определен диапазон от 

таксационни описания на ниво отдел. В полетата От отдел, До отдел се задават 
отделите за печат. Ако не желаете да се отпечатват предотделни листове то трябва 
да изключите отметката предотделен лист. Ако желаете в сегашния състав  да има 
запас и ползване с клони трябва да включите отметката.  
Опцията двустранен печат дава възможност за отпечатване на таксационни 

описания лице-гръб (1:а – 1:б; 1:в – 1:г;…). Когато опцията е избрана може да 
избирате между ръчно и автоматично обръщане на листата, като при автоматично 
обръщане принтера на които ще се печати трябва да поддържа Duplex печат. При 
ръчно обръщане на листата първо се отпечатват гърбовете след което излиза 
съобщения да обърнете листата за да бъдат отпечатени и лицата. 

 
Бутони: 
 

Име Описание 

 

Показва списък на всички подотдели попадащи в зададения 
диапазон 
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Име Описание 

 
Отпечатва таксационни описание от зададения диапазон 

 
Отказ от печат 

 
3.3.3 Печат на таксационни описания от списък 
 

 
Списъкът с отдел – подотдел трябва да бъде със сследната структура: 
 
отдел раделител подотдел 
 
Пример (в случая за разделител е избрано двоеточие “:”) : 
1:в1 
2:г 
2:ж 
16:а-1 
 
ВАЖНО! Никога не използвайте за разделител тире (“-“), защото е запезен знак при 

формирането на името на подотдела при проектиране. 
 
При избор на диапазон на печат от-до трябва да се съобразите с номеряцията отляво 

(колонката в сиво) за пореден номер.  
 
Пример: 
Ако искате да отпечатите всички описание от 52 отдел в диапазона от до трябва да 

напишете от 1 до 15, а не от 52 до 52. 
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3.3.3 Печат на предотделен лист 
 

 
Отпечатва предотделен лист на зададен отдел. Ако се включи отметката печат на всички 

програмата ще отпечата всички предотделни листове. 
 

 
 
3.3.4 Настройка на печат 
 

 
В секцията Полета за печат може да се редактират четирите полета на таксационното 

описание. От секция Копия  Брой  се задава броя на копията за всяко описание. 
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Бутони: 
 

Име Описание 

Стандартни 
полета Възстановява стандартно зададени от програмата полета 

Принтер Извиква настройки и избор на принтер 

Ок Отразява всички настройки 

Отказ Изход от настройките без да се отразяват 

* Настройките за Предотделен лист са както предходните. 
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3.4  Таблици 
 

 
 
3.4.1  Площи по отдели 
 

 
 
Показва списък на отделите и площа им. Ако искате да видите бърз преглед на подотделите 

кликнете два пъти с мишката върху реда на желания отдел. 
 

3.4.1.1  Запис и копиране 
 
 
Меню “Файл” – “Копирай”  копира списъка в клипборда и след това може да го вмъкнете в 

друга програма за допълнителна обработка.   
 
Меню “Файл” – “Запиши като” записва резултата в нов файл, като  формата съответно 

може да бъде MS Excel, МS Word, текст формат и DBF.  
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3.4.2  Площи по дървесни видове 
 
Показва списък на дървесните видове и площа им. 
 

 
Меню Файл виж 3.4.1.1   
 
3.4.3  Площи по зададен показател 

 
Показва списък с площи в зависимост от това какъв показател е избран.  
 

               

 
Меню Файл виж 3.4.1.1   
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3.4.4  ОГФ 1 - Отчет за разпределение на общата горска площ по вид на горите 
 

 
След като изберете вида на собственоста и предназначението натиснете бутона Ok за да 

стартирате изпълнението на таблицата,  от меню Файл може да отпечатите таблицата или да я 
копирате в клипборда и след това да я вмъкнете (Paste) в текстов редактор. 

 
3.4.5  ОГФ 2 - Отчет за разпределение на залесената горска площ по дървесни 

видове и класове на възраст 
 
Избора на вида на собственоста и предназначението е както в ОГФ 1 (виж 3.4.4) 
Поради вида на таблицата е препоръчително да използвате MS Excel за офомяне и 

разпечатване. От меню Файл изберете Копирай и след това от меню Edit на MS Excel 
изберете Paste зa да я вмъкнете. 
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3.5 Икони 
 
 

Име Описание 

 
Следващ подотдел 

 
Предишен подотдел 

 
Следващ отдел 

 
Предишен отдел 

 
Сито работно 

 
Печат на текущия подотдел 
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3.6 Менюта 
 
• Файл 

• Информация за проекта 

 
 

• Изход – изход от програмата 
• Останалите менюта са описани в предходните точки 
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3.7 Експорт 
 

 
3.7.1 Експорт на единични описания 
 
 

 
След като изберете отдел, подотдел и име на файла в които да се запишат данните бутона 

за експорт ще се активира. В случай, че желаете да експортирате повече от един подотдел в 
същия файл, то запазете името на файла същото и променяите само името на подотдела като 
сле всяка промяна натискйте бутона експорт. По същия начин може да експортирате и 
предотделни листа в същия файл в които са записани и таксационните описания. 
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3.7.2 Поточен експорт на описания 
 

 
 
Този начин на експорт ви дава възможност да зададете експортирането на данните да става 

на ниво отдел. 
 
3.7.3 Поточен експорт на описания от списък 
 

 
3.7.4 Настройки при експорт 
 
Преди да започнете експортиране на описания може да изберете дали да се експортира всичко 
от таксационното описания или части от него. Когато е избрана опцията за експортиране на 
части от таксационното описанието то формата на данните се ограничава да текстов 
файл. 
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3.8 Импортиране на таксационни описания и предотделни листове в  MS Word 

 
След като сте експортирали данните в текстов файл (виж т.3.7) стартрайте MS Word и 

отворете нов документ. Следвайте стъпките: 
 

• Изберете меню “Insert -> File”, от опцийте на отворилия се прозорец  изберете: 
 1.  Тип на Файла: Text Files 

2.  Директорията в която е записан текстовия файл 
 

 
3.  Изберете името на файла и натиснете бутона OK 
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• В зависимост от настройките на MS Word може да се отвори прозорец за потвърждение 
на типа на файла, изберете Text Only и натиснете бутона OK 

 
• Изберете меню File -> Page Setup и настройте полетата на листа по 2 cm 

 
Проверете размера на листа от секцията Paper Size, трябва да бъде A4 

 
• Селектирайте целия текст (Edit -> Select All) и изберете шрифт “Courier” или “Courier 

New” с големина 8 

 
• Изберете меню Edit -> Repalce.  
 

 
 
В полето Find what копрайте първия рад от предотделен лист, а в полето Replace 
whith копирайте същото но отпред добавете ^m, след това натиснете бутона Repallce 
All 
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Повторете същата операция и за таксационните описания, но полето Find what 
напишете “подотдел:”, а в полето Replace whith копирайте същото но отпред 
добавете ^m, след това натиснете бутона Repallce All 
 
• В случай, че сте експортирали само таксационни описания или само предотделни 

листове, е нужно да приложите само една от двете стъпки от от предходната точка. 
 
 


